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1.目的 

建立多功能大样品台原子力显微镜 Jupiter XR 标准使用操作规程，使其被正确、规范地

使用。 

2.范围 

本规程适用于所有使用多功能大样品台原子力显微镜 Jupiter XR 的用户。 

3.职责 

3.1.用户：严格按本程序操作，发现异常情况，尤其是仪器故障时，及时汇报实验室技

术员；隐瞒不报造成仪器进一步损伤将加重处理。 

3.2.实验室技术员：确保操作人员经过相关培训，通过考核，并按本规程进行操作。 

4.实验室安全管理规范 

4.1.进入实验室的所有师生应熟悉消防安全基本知识、化学危险品安全知识、用电/用水/

用气常识。 

4.2.严格遵守实验室的各项安全管理规范，注意警示标识。 

4.3.实验室仪器需经培训考核后方可操作，并严格遵守仪器标准操作规程（SOP）进行

检测，未经考核者严禁上机。严禁未经允许进行 SOP 以外的其他操作，或擅自修改

仪器硬件及软件设置、使用非指定部件，或在拆下安全装置的情况下操作仪器。 

4.4.严禁在实验室的仪器电脑主机上使用 USB 拷贝数据，严禁私自接入外部网络。 

4.5.用户自主测试必须严格按照 SOP 进行，实验过程中不得擅自离开实验室；实验结束

后，整理好实验相关区域并做好实验记录。实验室技术员应经常巡视，及时纠正违

规操作，消除安全隐患；  

4.6.用户须在制样区完成制样工作，并保持工作区域整洁，相关工具放置在指定位置；

仪器操作区要保持整洁，相关工具和资料放置在指定位置；严禁摆放与实验无关的

个人物品；严禁在实验室饮食与抽烟。 

4.7.禁止将自己的账号借给他人使用，尤其不可借给没有操作权限的人上机操作，一经

发现，直接取消使用资格。 

4.8.严格遵守学校规章制度，有毒废物、试剂、器皿、利器等分类回收。 

4.9.实验室人员离开前必须认真检查实验室的水、电、气是否关闭，离开时随手关门。 
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4.10.仪器操作过程中出现异响、异味、冒烟等异常现象时，请第一时间联系实验室技术

员。 

4.11.因违规操作或其他失误造成安全事故，相关责任人将受到通报批评及相应处罚。 

5.实验室仪器设备管理规范 

5.1.多功能大样品台原子力显微镜 Jupiter XR 使用制度 

该仪器遵从学校对大型仪器设备实行的管理办法和“集中投入、统一管理、开放公

用、资源共享”的建设原则，面向校内所有教学、科研单位开放使用；根据使用机时适

当收取费用；并在保障校内使用的同时，面向社会开放。 

多功能大样品台原子力显微镜 Jupiter XR (以下简称多功能大样品台AFM)检测方案

分为四类： 

(1) 培训测试：用户提出培训申请，技术员安排培训。培训内容包括：实验室规章

制度说明、多功能大样品台 AFM 基本原理、硬件构造及各部分功能介绍；常规样品制

样、仪器的标准操作流程、控制软件(AR.18.xx.xxx，持续更新)操作、数据处理及测试

注意事项。该过程中用户在技术员指导下进行操作仪器并进行数据处理。 

(2) 自主测试-初级：用户独立安装探针、制样、装样、独立操作多功能大样品台

AFM，进行气相的接触模式、轻敲模式测试形貌、高度、粗糙度信息，并进行简单的数

据处理。 

(3) 自主测试-中级：用户独立安装探针、制样、装样；独立操作 AFM 初级操作外，

进行液相、电学、力学的测试。 

(4) 自主测试-高级：用户独立安装探针、制样、装样；独立操作 AFM 初级、中级

操作外的其他测试模式，包括纳米拉伸台、外加光场、外加磁场的原位测试以及根据用

户的定制化需求设计实验方案进行测试。 

(5) 送样测试：用户预约时提供样品信息及测试要求；用户负责制样，技术员操作

仪器并做基本数据处理； 

该仪器的使用实行预约制度，请使用者根据样品的测试要求在学校“大型仪器共享管

理系统”(以下简称大仪系统)进行预约，并按照要求登记预约信息。 

5.2.预约制度 

为充分利用仪器效能、服务全校科研工作，根据测试内容与时间的不同，实验室制

定了多功能大样品台 AFM 7*24 小时预约制度。根据预约制度，获得操作权限的用户，
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可登陆大仪系统网站，自主预约使用，包括周末；国庆、春节假期等较长的假期，预约

制度根据学校和平台要求及时调整。 

多功能大样品台 AFM 采取综合计费制度，请遵守预约时间使用仪器，迟到、超时、

爽约导致的机时占用，均会收取费用，如果预约不合理，占用他人的机时，用户之间若

无法协商，则根据实际预约的时间为准。 

(1) 校内使用者须经过技术员的实验操作培训，考核合格后方可上机使用； 

(2) 实验开始时务必在实验记录本上登记，结束时如实记录仪器状态； 

(3) 严禁擅自处理、拆卸、调整仪器主要部件。使用期间如仪器出现故障，使用者

须及时通知技术员，以便尽快维修或报修，隐瞒不报者将被追究责任，加重处理；  

(4) 因人为原因造成仪器故障的(如硬件损坏)，其导师课题组须承担维修费用； 

(5) 不可擅自做除培训操作之外的测试，如有需求请务必联系技术员；  

(6) 数据不允许用 U 盘或其他移动存储直接拷贝。使用者应根据要求通过数据共享

系统保存和下载原始数据至本地电脑；实验数据在本实验室电脑中保留 2 个月(暂定，

根据情况若硬盘允许数据保存时间延长)。 

(7) 使用者应保持实验区域的卫生清洁，测试完毕请及时带走样品，本实验室不负

责保管样品。 

(8) 实验室提供镊子、螺丝刀、胶带、银胶等专用装针和制样工具，请合理使用，

用户不得私自带走。 

(9) 使用者若违犯以上条例，将酌情给予警告、通报批评、罚款及取消使用资格等

惩罚措施。 

5.3.培训考核制度 

校内教师、研究生均可提出预约申请，由技术员安排时间进行培训，培训分为三部

分： 

第一部分：由实验室技术员介绍实验室规章制度、安全管理规范、仪器设备原理、

基本硬件知识。 

第二部分：上机培训，内容包含：装针、制样、仪器标准操作规程、相应数据处理。 

第三部分：上机培训结束后，培训者需根据实验安排，使用自己的样品进行预约上

机测试（建议两周以内），在技术员的监督下进行独立操作。待培训申请人觉得可以独

立操作后向技术员申请进行上机考核。 

考核通过之后，技术员会给予培训者授权，培训者即可独立使用仪器，但仅限在其



多功能大样品台原子力显微镜 Jupiter XR V1.0               第 4 页 /共 25 页 

  

 

用户级别所允许的可操作实验范围内使用。个别因为人为操作错误导致仪器故障者，除

按要求承担维修费用之外，给予降级重考惩罚、培训费翻倍。 

注意：培训中的第一部分和第二部分需要用户在一周内完成(特殊情况除外)，否则需要重新进行

培训；培训通过后用户需保证每两个月至少 1 次的自主上机测试，若超过该时间则需要重新联系仪

器负责人监督考核，否则将无法预约该仪器设备。考核不达标者需要重新申请培训，且培训费用是

初次培训的 1.5 倍。 

对接受培训人员的核心要求： 

(1) 熟悉多功能大样品台 AFM 原理、构造及各部分的功能，严格遵守仪器部件的

开关顺序，在突然停电时能及时处理并上报，关注仪器各部件有无异常； 

(2) 熟练掌握多功能大样品台 AFM 的原理及操作，严格按照标准操作规程操作，

防止因人为操作不当造成仪器故障，特别注意 Z scanner/holder 的安全使用、手动预下针

操作、Stage 的安全操作，人为原因造成的仪器事故，所属课题组须承担维修费用，认

真做好仪器使用及故障记录。 

5.4.仪器故障报告 

(1) 仪器使用过程中，仪器出现故障及错误提示信息时，应即时通知技术员； 

(2) 请在第一时间将故障及错误提示信息截屏，并保存在桌面“Error Report”文件夹，

截屏文件命名请按照“导师名-用户名-样品名-故障时间(具体到分钟)”；在《仪器设备使

用记录本》的备注栏做简单说明。 

6.多功能大样品台原子力显微镜 Jupiter XR 标准操作步骤 

6.1.介绍 

基本信息：多功能大样品台原子力显微镜 Jupiter XR 主机（包括主体、ARC2 控制

器、操作杆、真空控制器、减震控制器、电脑及操作软件）；气相成像模式、液相成像

模式、电学模式、高压模式、buleDrive 光热激发模块、力学模式、SCM 模式，外加力

场、光场、磁场模式。 

仪器主要技术参数： 

XY 方向最大扫描范围：100 * 100μm 

Z 方向最大扫描范围：12μm 

系统 XY 方向闭环噪音水平：150pm 

系统 Z 方向闭环噪音水平：35pm  
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样品台直径：200mm 

样品台移动范围 200 *300mm 

导电测试：电流范围：1pA-20nA，精度：1pA 

SCM 模式：横向分辨率＜20nm，电容灵敏度＜1aF，载流子浓度测试范围：

1*1015~1*1020 

高压模式：电压范围：0-150V，兼容所有的 PFM 模式。 

纳米拉伸台：最大拉力值 80N，力学分辨率 0.2N，拉伸精度 500μm。 

外加磁场模块：水平方向 0-8000oe，垂直方向 0-1200oe，分辨率 10oe 

外加光场模块：从样品底部引入外加光场垂直照射样品，通过 0.5``直径光纤引入，

样品上的最大光强为光纤光强的 1/2。 

仪器主要组成： 

如下所示： 

 

图 6-1 多功能大样品台原子力显微镜 Jupiter XR 系统图示 
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图 6-2 ARC2H 控制器（左）、AFM XYZ 扫描器（右） 

ARC2H 控制器： 电源开关和激光钥匙在前面板的左下方。 电源开关拨至“I”为开，“O”

为关。激光钥匙打平为开。 

      

图 6-3 Sample Chuck 样品真空吸盘（左）、样品盘上的功能分区（右） 
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图 6-4 Z Scanner with Cantilever Holder 

Z scanner with Cantilever Holder 安装了探针加持器的 Z 扫描器，红色标记部分是

探针加持器（holder）。 

6.2.样品准备 

测试样品要求干净，表面平整，高度起伏不要超过 12μm。 

6.3.探针准备 

根据自己的样品准备合适的探针，如果是比较重要的样品，或者测试结果用于文章

发表，建议使用新的探针。请用户自行准备测试探针，公共探针仅用于培训，用户独立

测试不提供探针。 

6.4.系统检查 

测试前请完成如下检查： 

测试前先确认 ARC2H Controller 的 Power 灯亮，Laser 钥匙位于 Off 的位置。如果不是

该状态，请联系仪器负责人。 

6.5.制样 

   建议利用双面胶、导电银胶、AB 胶将样品粘到样品托上（样品托直径约 15mm），

如果样品较大也可直接放置在样品台上。所有放入的样品都要保证在样品台上稳定放

置，不能在测试时发生移动。 

警告：1. 制样时，需要确保待扫描的区域位于样品的最高点，更不要如下图 6-5 所示在样品托上放

置比样品高度更高的物体，一个样品托上只放置一个样品。 

2.  AFM 的制样工具，样品托、镊子、螺丝刀均为实验室公共用品，请爱惜使用，不可带走。 
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3.  测试开始和结束后，需用无尘纸蘸取酒精认真清洁样品托的两面，并带走或者处理自己的样品，

不可一直占用公共样品托。 

                      

图 6-5 

6.6.仪器操作 

（1）输入账号和密码，登录大仪系统，进入电脑桌面。 

（2）在电脑桌面上找到双击打开软件“AR18”，打开控制器上的激光开关 Laser，从

“off”旋到“on”（以上两项顺序无固定要求）。等待软件下方显示“Ready”和

绿底的√： 

 

注：如果软件报告缺失某些部件， 点击 AR 软件左下角“AR“logo，点击弹出窗口的右

下角”Rescan”按钮（如下图）。如果仍没有解决问题，请联系仪器负责人。 

（3）选择测试模式。在当前软件中会弹出“Mode Master” 窗口，左侧的 Probe Panel

窗口，选择 No，并点击 OK 关掉，然后选择“AC Air Topography”，进入轻敲

模式的软件环境。如果没有弹出该窗口，点击软件左下方的按钮 。 
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图 6-6 

（4）在 Engage Panel 中，点击 Change Cantilever（如按钮已经是绿色，可跳过本步

骤） 

 

图 6-7 

（5）旋转门把手，打开隔音罩，把隔音罩门推到一侧，打开下方照明灯开关。 

（6）取下 Z Scanner。注意：务必在 OK to Remove 灯亮时操作！向下按压 Z Scanner

旁边的绿色把手，旋转 180 度，双手操作，从两侧抓紧，平稳滑出 Z Scanner，

翻转 Z Scanner，holder 向上，轻轻将其安全放置在制样台上。 

警告：务必拿稳 Z Scanner，不可掉落！ 

（7）更换 holder。仪器默认安装 AIR holder，如需要其他 holder，需用户自行更换。

请在装针前，选择正确的 holder，并检查 holder 是否有异常，如裂痕、脏污
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等问题，发现问题请及时告知仪器负责人。使用专用的两把螺丝刀，拧松固

定 holder 的一大一小两个螺丝，即可更换 holder。 

（8）装针。 

i．用洗耳球吹扫一下弹片，确保没有探针残渣。转动螺丝半圈（不要过多！），

使压探针的弹片弹起，探针可移动即可。 

ii．用专用的探针镊子夹取探针 chip 的中间部分，小心的放在金属弹片下，

调整位置并尽量使其处于限位槽中间，稍微拧紧压片的固定螺丝即可。 

iii． 拿起 Z 扫描器，从侧面平视探针，探针尖端会略微翘起，如果探针伸入

太多，则有可能导致探针的角度不对，以至于影响激光对准。。 

      

图 6-8 

警告：1. 装针前用吸耳球认真吹扫 holder 的压片和玻璃部分，确保没有 chip 的碎片残留，否则

拧紧螺丝时可能会损伤玻璃。 

2. 固定螺丝时，稍微拧紧固定探针即可，请勿过度用力，可能会夹断探针，或导致螺丝滑丝，

弹片过度弯曲。 

3. 拧松螺丝时，不要超过半圈，压片抬起即可，不慎将螺丝拧掉，会有丢失和滑丝的风险，后

果非常严重，有可能会导致整个 holder 需要更换，务必注意。 

4. 在手持 Z Scanner 时，务必拿稳，不慎掉落会造成 Z Scanner 损坏。 

（9）装回 Z Scanner。抓紧 Z 扫描器，对准楔形轨道轻轻地推到底，把绿色的把手

向上拨紧，锁定 Z 扫描器。 
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图 6-9 

（10）放样品。在 Engage Panel 中点击“Change Sample”，待样品台移动出来，放置样

品。如果样品是粘在小铁片上，样品盘上 8 个磁吸点都可以放样品。在下拉选项中

选择放置样品的正确位置，再点击 Engage Panel 中的“Move to Position”。此

时 XY 位移台会把样品移动到探针下方。 

警告：样品台周围的台面不可放置任何物品，否则样品台移动时会卡住损坏！ 

注意：1. 小样品建议放在样品托上，放在磁点处，便于定位。 

      2. 建议高度差别很大的样品分批放入，或者放置距离较远，确保 Z Scanner 安全移动，

不会撞到。 

 

图 6-10 

（11）轻缓关闭隔音罩， 拧紧旋钮。 

（12）进针。通过隔音罩的玻璃窗水平直视样品和探针，按住 JoyStick 的进针按键，向下

推操纵杆，物镜和探针协同向下，靠近样品，直至探针离样品 2-3mm。 

Joy Stick 说明：a.进针 b.样品台气浮 c.样品台照明 
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图 6-11 

警告：1.在操纵探针靠近样品的时候，眼睛一定不能离开样品和探针，如果操作失误样品探针相撞

会造成非常严重的损坏。 

2. 探针下降的速度随着摇杆移动幅度的变大而变快，建议用户以小幅度来移动摇杆，以防探针撞到

样品上，严重的情况下会损坏 holder 和 Z Scanner。 

（13）聚焦探针。在“Video”窗口，在 Zoom1.0 条件下，点击“Home”按钮，可以大致

看到悬臂梁的轮廓，之后在“Engage Panel”窗口中，上下调节物镜焦距（请注

意！要选择“Move Focus”才能调节物镜），单箭头为慢聚焦，双箭头为快聚

焦。确定针尖聚焦面后，点击“Focus On Tip”旁边的“SET”。  

 

图 6-12 

a   b   c     
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（14）下激光。在针尖上点击右键，选择“Spot On”，此时，激光光斑应出现在相应

位置，可以借助左上角标黄的箭头调整激光的位置，按住 Shift 键可以实现微

调。 

注意：激光调整原则：①尽量靠近针尖；②“Sum and Deflection Meter”窗口中，“Sum”值尽量大，

在 3 以上；③不要漏光。 

（15）针尖定位。在“Video”窗口，点击“Tip Pos”，鼠标箭头会变成一个小旗子，

放在针尖上，然后鼠标再次点击“Tip Pos”，变回鼠标箭头模式。 

（16）聚焦样品表面。继续向下调节聚焦，直至聚焦在样品表面上，点击 Focus on 

Sample 的右侧的 SET 按钮，此时可以看到 Sample Height 的数值会更新。 

（17）点击图 6-12 中标黑的“Move To Pre-Engage”按钮，这会使探针位于样品表面

70μm 的位置。观察激光光斑是否有偏移，如果有可以微调其位置。 

警告：如果前面设置的探针位置和样品高度错误的话，这一步很有可能会使探针撞到样品上发

生损坏！所以两个聚焦面设置好之后，请仔细检查一下！防止探针撞坏，甚至 holder 再进一步

撞到样品上，造成更严重的设备损坏！ 

（18）点击“Sum and Deflection Meter”窗口的 Zero PD，使 Deflection 调零（接近 0

即可）。 

（19）寻峰/Tune，即寻找所用探针的共振频率并设置空气的 Free Amplitude 值

（Target Amplitude），点击“Master Panel”窗口右侧栏的“Tune”按钮，

“Cantilever Tune”窗口会弹出，点击“Auto Tune”按钮即，稍等片刻，可以观

察到寻峰结果，寻峰得到的相关参数（Drive Amplitude 和 Drive Frequency）

会自动保存，此时可以关闭该窗口。 

 

注：可以根据探针盒子上标明的频率范围，点击该窗口右侧的“Parms.”，手动修改 Auto Tune 

Low/High 的值，设备寻峰范围。 

 

    

图 6-13 
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（20）设定扫设置和优化扫描参数。 

 

图 6-14 

i．“Scan Size”：扫描图片的区域大小，Jupiter XR 的上限为 100μm，根据需要自行设定； 

ii．“Points&Lines”：每行的扫描点数*扫描行数，请选择 256 的倍数； 

iii．“Scan Rate”：扫描速度，默认 4.88Hz，通常 2.44Hz 以内；较软的样品，建议扫描

速度慢一些； 

——以上三项参数，均根据实际的实验需求设置，还可以点击右侧栏中的“Parms.”，在

弹窗中进行更多设置。 

iv．“Setpoint”：在轻敲模式下，Setpoint 和悬臂的自由振幅 Free Amplitude（即为 Auto 

Tune 步骤中设置的 Target Amplitude）的比值体现扫图过程中探针力的大小，所以

Setpoint 的数值必须设置为小于自由振幅 Free Amplitude 的值。但是由于在通常 Auto 

Tune 时，将自由振幅设为 1V，所以可以近似理解为 Setpoint 值越小，探针施加的

力越大，反之亦然 

v．“Integral gain”：反映了系统反馈的灵敏度，为了得到高质量的图像，在扫描过程中，

建议尽可能增大，以提高灵敏度，直至图像尚未产生噪音为止，通常在 80 以内。 

vi．“Drive Amplitude”：表示压电陶瓷的驱动振幅，扫图过程中，如果调小 Setpoint 依

旧不能得到满意的结果，可以增加该值，会增加探针的振幅，建议 Drive Amplitude

和 Setpoint 同步调大，以保护探针。 

——以上三项参数，在扫描过程中根据图像情况实时调整。 



多功能大样品台原子力显微镜 Jupiter XR V1.0               第 15 页 /共 25 页 

  

 

（21）进针。点击“Engage Panel”窗口中的“Start Tip Approach”按钮，开始自动下针，

下针成功后会有警示音发出。 

 

图 6-15 

（22）开始扫描。在“Master Panel”界面，点击“Frame Up”或者“Frame Down”开始扫

描。 

 

图 6-16 

注：轻敲模式下 AFM 会检测悬臂振幅的变化。随着探针向下移动，悬臂的振幅也会随之衰减， 当

其从  Free Amplitude 衰减到  Setpoint 时即认为下针成功。所以可以理解当我们加大  Drive 

Amplitude（导致 Free Amplitude 加大），或者减小 setpoint 时，都会导致探针向下移动的距离 增

加，即探针与样品的距离变小。 

（23）扫描过程中参数的调节。扫描过程中应观察 Height Retrace 窗口下的红蓝线

是否重合，如果红蓝线完全重合，表明此时 的扫描参数设置的合理，不需要

进一步调节。  

如果红蓝线并不重合，可以尝试如下几步： 

~增加探针的力的大小，即减小 setpoint 或者增大 Drive Amplitude。  

~增加反馈系统的灵敏度，即增大 Integral Gain 值。注意：过大的 gain 值会引起系

统震荡，体现为图中出现明显波纹状噪音。  

~降低扫描速率即 scan rate。 
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~若仍不能使红蓝线重合，应考虑探针选择是否合理，或是否当前探针已经被污染

或磨损，尝试更换新的探针  

（24）图像显示参数的调节。在“Master Channel Panel”界面的上方一栏或者在

“Input” 的 下 拉 菜 单 中 ， 可 以 选 择 想 要 设 置 的 图 像 通 道

（Height/Amplitude/Phase/ZSenor）。 

 

图 6-17 

i. “ColorMap”：可以选择图像颜色，在其下拉菜单中，点击一下“Setup”，可以获得更多

颜色选择。 

ii. Image Modification 中，“Real Time”选项，可以选择合适的实时数据拉平条件，一

般选择 Flatten 1，“Saved”选项中，对 Height 选择“None”，以保存原始数据，也可根

据样品实际情况选择。 

（25）关于引力扫描和斥力扫描 

i．在轻敲模式下，相位/Phase 值的大小可以反映探针和样品间作用力的类型，当 Phase< 

90°时 处于斥力模式；而当 Phase> 90°时处于引力模式。 我们通常认为引力扫描时，

由于探针并未“真正的敲击”在样品上，所以对于探针和样品的保护性都很好，但牺牲

了一定的图像分辨率。而斥力扫描则相反，往往可以得到较为“清楚”的扫描图像，但

是对于探针和样品也会多多少少有一点磨损。 我们可以根据自己的样品来选择引力

或斥力模式进行扫描，但注意一定要避免探针不断在引力与斥力模式间跳动（mode 

hopping），即 Phase 不断在 90°上下跳动。  
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ii．使探针在扫描过程中维持在斥力模式 ：通过增加 Drive amplitude 从而使探针的 free 

amplitude 增大，越容易进入斥力模式。 设置的 setpoint 越小，越容易进入斥力模式。 

iii．值得注意的是，之前谈到过扫描过程中探针上力的大小取决于 setpoint 和 Free 

amplitude 的比值，所以在调节这两个值的时候需要保持这个比值大约在 50%~80%之

间，即在逐渐增大 Drive amplitude 的同时也逐渐增大 setpoint，直到 phase 稳定在

小于 90°的范围内。 

iv．能否进入斥力模式，和探针、样品都有关系。 

样品越黏，越软，有静电力，都会造成难以进入斥力模式。  

探针越硬（k 值越大），越容易进入斥力模式。  

探针越尖，越容易进入斥力模式。所以磨损的或者污染的探针，可能不容易进入斥力模

式。 

（26）其他注意事项。 

i．开始之后，检查一下“Sum and Deflection Meter”界面中的 Z Voltage 的值，推荐在中间

区域，70-80 左右，如果一直处于最大值（150），则说明之前下针未成功，需要停止扫

描“Stop”，减小 Setpoint 重新下针，再开始。如果一直处于最小值（-10），这说明之前

样品表面定焦有问题，需要停止扫描“Stop”，点击“Move To Pre-Engage”，增加 Setpoint

重新下针，再开始扫描。 

ii．如果扫描过程中想改变区域：①在扫图范围内改变，可以直接左键画框 Zoom 或者

输入 X，Y offset 值；②在同一个样品上大范围移动（video 窗口范围内），停止扫描

（“Stop”），点击“Pre-Engage”，再移动样品台。③如果一次放入多个样品，需要改变扫

描的样品，停止扫描“Stop”，用操纵杆抬针至安全高度（如样品表面 1cm 左右），再

移动样品台。切勿直接移动探针，有可能损坏探针！ 

6.7 实验结束 

扫描结束后，点击 Engage Panel 中的“Change Sample”，取出样品，再点击“Change 

Cantilever”，取下探针，把 Z Scanner 放回仪器中。如果使用了其他 holder，要更换回

AIR Holder。关上激光并关上软件，退出大仪系统，收拾桌面和制样区，带走或自行处

理自己的样品。在实验记录本上做好使用登记。无需关闭控制器和电脑。 
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6.8 数据处理及保存 

（1）保存数据。扫完一幅图，软件会自动保存数据，默认保存在以当天日期命名的

文件夹中，路径为 D:/Asylum Research/日期。实验数据使用校内共享存储系统进行上传

和下载，首次使用需要用户使用桌面的快捷方式自行建立自己的文件夹。建议选择需要

的数据复制粘贴到自己文件夹中。 

（2）打开数据。方法一：点击菜单栏中的 AFM Analysis→Browse Save Data，在弹

出的 AR Load Path 面板中，点击 Browse，选择数据所在文件夹，在弹出的 Browse 面板

中，可以看到文件夹中的数据，如果要更改路径，点击 Browse 面板的 Change Directory

按钮。 

 

图 6-18 

方法二：Browse 面板中，双击图标就可以打开数据。如果想直接打开已有的数据 ibw

文件，首先打开 AFM 软件，再把 ibw 文件拖进去，最好不要用双击 ibw 文件的方式打

开数据。 

（3）数据后处理。点击图像上方的 M 按钮，打开 Modify 面板。 
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图 6-19 

Modify 面板最常用的功能是 Flatten 和 Planefit，它们的作用是拉平形貌图像（Height

高度图和 Z Sensor 图），Flatten 和 Planefit 一般不用于形貌图之外的图像。 

 

图 6-20 

Planefit 是将形貌图整体调平，消除图像的倾斜。选中所要处理的图像和通道，

Planefit Order选择1，点击XY（代表Planefit作用于图像的X和Y方向）。1阶和Histrogram 

Planefit 最常用，0 阶只消除 offset，用处不大，2 阶可能改变形状，慎重使用，请根据

最终图像的消除倾斜的效果选择。 
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图 6-21 

Flatten 是将 AFM 的扫描线逐一对齐。Flatten 是逐行调平、对齐，类似于对每条线

分别做 Planefit。选中所要处理的图像和通道，选择合适的 Flatten Order，点击 Flatten，

如果效果不好，可点击 Undo Flatten。1 阶和 Histrogram Flatten 最常用，0 阶 Flatten 可

以对齐线，也会用到，2 阶可能改变形状，慎重使用。 

 

图 6-22 

以上对图像的处理（Flatten，Planefit），都只对内存中的数据生效，硬盘中保存的

数据不受影响。重启软件后打开数据，依然是处理之前的样子，要保存对图像的处理，

可以选择 Commands 下拉菜单的 Save Image（覆盖原数据），或者 Save As …（数据另

存为） 
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图 6-23 

对图像进行后处理（Flatten，Planefit）之后，都可通过点击 Restore Layer 或者 Ultra 

Restore Layer 恢复原始数据，不必担心保存更改后回不去。 

（4）图片颜色和对比度调节。在数据中的 ColorMap 下拉菜单可以选择颜色表，点

击 Auto 可以自动调节颜色的显示，利用 Range / Offset 可以手动调节颜色的显示。 

 

图 6-24 

（5）导出图片或数据。 
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i．选中图像，菜单栏 File→Save Graphics，在 Format 选择导出的格式（一般选择 TIFF

格式）， 点击 Do It，设置导出的名称和路径。 

ii．点击图像上方的 Ly 按钮，也可以将图像复制到 Layout（类似一个剪贴板），除了图

像，截面线、直方图、Mask 等元素也可以保存到 Layout，Layout 可以通过菜单栏

File→Save Graphics 或者 Print Layout 保存为图片或 PDF 报告。Layout 中的元素也可以

被复制粘贴到 Office 软件中。 

iii．AFM 图像是一个个数据表格，数据可以导出，在数据图片的 Commands 下拉菜单，

选择 ASCII Export，即可保存为 txt 格式。 

iv．对于形貌图（高度图和 Z Sensor 图），软件也可以生成 3D 图像，点击图像上方的

3D 按钮，就会生成 3D 图像。鼠标左键旋转模型，右键改变光照角度。3D 图像不能用

Save Graphics 导出，要用菜单栏 Edit→Export Graphics 导出。 

6.9 数据分析。 

数据分析的功能主要在 Analyze 面板，点击图像上方的 A 按钮，打开 Analyze 面板。

常用的数据分析工具有 Roughness（粗糙度等统计值）和 Section（截面线）。 

 

图 6-25 

（1）Roughness 页面给出形貌图的统计信息。Sdev [Rq]和 Adev [Ra]常用来描述粗糙度；

Max / Min：数据点中的最大值/最小值；Avg：数据点的平均值；Area：样品表面

积；Area %：样品表面积相比扫描范围多出来的比例；Volume：样品体积，相对

于 Z = 0 平面 
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图 6-26 

（2）Section 用来读取图像在一条线上的数据。对于形貌图来说，就像做了一个截面。

点击 Draw，在图像上画一条线，出现截面线，拖动两个光标可以改变线的位置，

点击 Clear 可以删除截面线。Mode 有两种，Line（直线）和 Free Hand（自由轨

迹）；在 Line 直线模式下勾上 Full，截面线贯穿图像；在 Line 直线模式下勾上

Angle 方框，输入角度值，可以限定线的角度；增大 Width，截面线变宽，有平

均的效果，数据可能更平滑； 

 

图 6-27 
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截面线窗口的下方是 Cursor 工具栏。 Cursor 工具栏可以通过键盘的 Ctrl+I 隐藏或

显示，用鼠标把 Cursor 拖到曲线上，就可以得到那一点的 X 和 Y 数值。用两个 Cursor，

还可以知道它们的 X 差值和 Y 差值。在截面线窗口点击 Edit，会出现数据表，可以保

存为 csv 文件或复制到别的软件； 

 

图 6-28 

 

7.相关/支撑性文件 

7.1 Q/WU FLHR001 文件编写规范 

8. 记录 

8.1 多功能大样品台原子力显微镜 Jupiter XR V1.0 
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仪器设备使用记录本                                20   年 

日期 

月.日 
测试人 导师（PI） 样品名称、状态及数量 

实验内容 

（Contact/AC/CAFM/PFM/Forc

e Curve……） 

检测方式 

使用时间 备注 
送样 自主 

         

         

         

         

         

         

         

         

         

请注意：(1) 使用前先检查仪器状况，一切正常方可操作；一旦开始实验，默认为使用前仪器及各个配件状况良好；(2) 使用过程中出现故障须立即联系技术员；测试

后请及时取回样品;  


